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For your safety
For your safety

Read these simple guidelines. Breaking the rules may be dangerous or illegal. 
Further detailed information is given in this manual.

Do not use the PC card when wireless equipment use is prohibited or when 
it may cause interference or danger.

Road safety comes first
Don’t use while driving.

Interference
All PC cards may receive interference, which could affect performance.

Switch off in hospitals
Follow any regulations or rules. Switch the PC card off near medical 
equipment.

Switch off in aircraft
Wireless devices can cause interference in aircraft.

Switch off when refuelling
Don’t use the PC card at a refueling point. Do not use near fuel or chemicals.

Switch off near blasting
Don’t use the PC card where blasting is in progress. Observe restrictions, 
and follow any regulations or rules.

Use sensibly
Use only in the normal position. Don’t touch the antenna unnecessarily.

Qualified service
Only qualified personnel may repair PC card equipment.

Water-resistance
Your PC card is not water-resistant. Keep it dry.

Backup copies
Remember to make backup copies of all important data.

Connecting to other devices
When connecting to other devices, read the other device’s user guide for 
detailed safety instructions. Do not connect incompatible products.
1



For your safety
Network Services
The PC card described in this guide is approved for use in GSM 850 and GSM 1900 
networks.

A number of features included in this guide are called Network Services. These are 
special services that you arrange through your wireless service provider. Before 
you can take advantage of any of these Network Services, you must subscribe to 
them through your wireless provider and obtain instructions for their use from 
your wireless provider.

Note: Some GSM networks may not support all language-dependent 
characters and/or services.
2



Introduction
Introduction

The Nokia D311 PC card is a multi-mode PC card that combines General Packet 
Radio Service (GPRS), GSM data, and Wireless Local Area Network (WLAN). 

With the Nokia D311 PC card you can send and receive e-mail, text messages, data 
and fax files, and access the Internet. 

Note: You cannot make or receive voice calls with the Nokia D311 PC card.

The Nokia D311 PC card operates on the GSM 850 and 1900 networks and IEEE 
802.11b-compliant WLANs. It plugs into compatible portable computers or other 
devices with a type II or III PC card slot. The Nokia D311 PC card is equipped with 
an integrated smart card reader, Wired Equivalent Privacy (WEP) keys, and 
personal network profiles that make moving between networks easy. 

Supported operating systems are: Windows 98 Second Edition, Windows Me, 
Windows 2000, and Windows XP. For other supported operating systems and 
software updates, please check the Nokia Web site at www.club.nokia.com.

Important!
Warning: Do not use the PC card when the use of a wireless device is 
prohibited or when it may cause interference or danger. 

Warning: Be careful when moving your computer so that you do not cause 
damage to the protruding end of the PC card.

Warning: Using the Nokia D311 PC card in some countries or regions may 
be illegal. Consult local authorities on the regulations concerning the use of 
the Nokia D311 PC card.

Note: Transmitted data is not encrypted by the PC card by default.

Warning: Use only accessories approved by the PC card manufacturer 
for use with this particular PC card model. The use of any other types 
may invalidate any approval or warranty applying to the PC card, and may 
be dangerous.

For availability of approved accessories, please check with your dealer.
3
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Introduction
Data and fax communication
The Nokia D311 PC card provides the functionality of a wireless modem. In order 
to connect to a remote computer, send and receive files, e-mail, and faxes, as well 
as access the Internet, please take the following into account:

• You will need the appropriate data and fax communications software on your 
computer. The Nokia D311 PC card is compatible with a variety of commercially 
available Windows 98 Second Edition, Windows Me, Windows 2000, and 
Windows XP compatible data and fax communications applications, such as 
Dial-Up Networking and HyperTerminal. 

• The data and fax applications that reside on your computer must be correctly 
configured for use with the Nokia D311 PC card. Follow the instructions given 
in the documentation of these applications and remember to select the Nokia 
D311 PC card as the modem for each application.

• The data transfer and fax functions depend on the applications you have 
chosen, and not only on the computer or the Nokia D311 PC card. For 
information on how to use an application, please refer to that application’s 
documentation.

• You need to subscribe to the corresponding data and fax services from your 
wireless provider. Contact your wireless provider for information about the 
availability and details of the services in your home network. Internet access 
requires that you have subscribed to the data service and obtained an Internet 
access point from your wireless provider.

The Nokia D311 PC card can also be controlled with AT commands.

About data transmission
The Nokia D311 PC card employs data transmission capabilities of WLAN and GSM 
networks in order to send and receive data, browse the Internet, send short 
messages and e-mail, and to establish connections with other computers.

Data connections may be made from most locations where your PC card operates. 
However, it is recommended that you move the PC card to a location where the 
strongest possible network signal can be obtained. When the signal is strong, data 
transmission is more efficient. 

Factors that may impair wireless connections:
Interference – Electronic appliances and other equipment can cause radio 
interference. Also in areas where PC cards are prevalent, other PC cards can impair 
your wireless connection.
4



Introduction
Roaming – As the PC card user moves from one WLAN access point coverage area 
or GSM network cell to another, the signal strength may drop. As a consequence, 
the network may hand the user over to a coverage area and frequency where the 
signal is stronger. Due to varying network traffic loads, roaming may also occur 
when the user is stationary. Such roaming may cause slight delays in transmission. 

Electrostatic discharge – A discharge of static electricity from a finger or a 
conductor may cause erroneous functions in electrical devices. The discharge may 
result in unstable software operation. Network connections may become 
unreliable, data may become corrupted, and transmission halted. In those cases, 
end the existing connection (if any), stop the PC card, and remove it from the PC 
card slot. Then re-insert the PC card into the PC card slot and try connecting again.

Dead spots and dropouts – Dead spots are areas where radio signals cannot be 
received. Dropouts occur when the PC card user passes through an area where the 
radio signal is blocked or reduced by geographical or structural obstructions, such 
as concrete walls.

Signal impairment – Distance and obstacles can cause signals to become out-of-
phase. They can also cause reflected signals. Both situations result in a loss of 
signal strength.

Low signal strength – Due to either distance or obstacles, the radio signal 
strength from a WLAN access point or GSM cell site may not be strong or stable 
enough to provide a reliable connection for communication. Therefore, to ensure 
the best possible communication, remember to consider the following points:

• Data connection works best when the PC card is in a stationary position. 
Attempting wireless data communication while in a moving vehicle is not 
recommended. Fax transmission is more easily impaired than data or text 
message transmission.

• Do not place the PC card on a metal surface.

General Packet Radio Service (GPRS)
Important:  GPRS may not be available in all wireless networks. The 
establishment and continuation of a GPRS and Internet connection 
depends on network availability, wireless provider support, and signal 
strength.

GPRS is a packet data technology where information is sent in short bursts of data 
over the mobile network. The benefit of sending data in packets is that the 
network is occupied only when sending or receiving data. GPRS as such is a data 
bearer that enables wireless access to data networks like the Internet. The 
applications that use GPRS are SMS messaging and GPRS dial-up (for example, 
the Internet and e-mail).
5



Introduction
Before you can use GPRS technology: 

• You need to subscribe to GPRS service.

For availability and subscription to GPRS service, contact your wireless 
provider.

• You need to save the GPRS settings for the applications used over GPRS.

See “Messages” on page 31 for configuring text message settings.

See also “Create new profiles” on page 21 and “Data and fax communication” 
on page 4.

Please refer to the Data Security document found on the Nokia D311 PC card CD-
ROM for information on security issues.

Pricing for GPRS and applications
Confirm the cost of operating your PC card with your wireless provider. You may 
be charged for the GPRS connection and any data that is sent and received over 
the connection.

Wireless Local Area Network (WLAN)
The PC card described in this document is approved for use in a Wireless Local Area 
Network (WLAN).

The Nokia D311 PC card supports the following WLAN features:

• IEEE 802.11b standard

• Data rates of 1, 2, 5.5, and 11 Mbit/s

• Operation at a frequency of 2.412 - 2.462 GHz using Direct Sequence Spread 
Spectrum (DSSS) radio technology

• Wired Equivalent Privacy (WEP) data encryption with keys up to 152 bits.

The Nokia D311 PC card enables you to connect compatible laptop computers, 
hand-held devices, desktop PCs, and other devices with a type II or III PC card slot 
to a local area network through a WLAN access point. Instead of cables, radio 
waves are used to transmit and receive data over the air.

If you move the computer to another location within the WLAN and out of range 
of a WLAN access point, the roaming functionality can automatically connect 
your computer to another access point that belongs to the same network. As long 
as you remain within range of access points that belong to the same network, your 
computer can stay connected to the network.
6



Introduction
The Nokia D311 PC card enables different types of communication in a WLAN. 
There are two operating modes to choose from: infrastructure and ad hoc.

Infrastructure
The infrastructure operating mode allows two kinds of communication:

• Wireless stations communicate with each other through a WLAN access point.

• Wireless stations communicate with a wired LAN station through a WLAN 
access point. 

The advantage of the infrastructure operating mode is that you can have more 
control over network connections because they pass through an access point. A 
wireless station can access the services that are available in a regular wired LAN: 
company database, e-mail, the Internet, and other network resources, for example.

Ad hoc
In the ad hoc operating mode, wireless stations send and receive data directly with 
each other; no access point is required. Simply insert the PC cards into the 
stations, make the necessary configurations, and start communicating. Ad hoc 
networking is easy to set up, but communication is limited to stations that are 
within range. As long as the stations are within range, you can, for example, share 
and exchange files.

Figure 1 - Infrastructure network

WLAN access point
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Introduction
See “Set up and join ad hoc networks” on page 17 for how to set up an ad hoc 
network.

SIM services
SIM services refers to a service which enables you to access the Internet via your 
wireless service provider’s own public network. Your wireless provider may, for 
example, offer you the possibility to check data from your company intranet, send 
and receive e-mail, and save documents. SIM services are usually available in 
public places such as hotels, airports, railway stations, business centers, and 
corporate buildings.

Note: Before you can take advantage of the SIM services, you must 
subscribe to these services from your wireless provider and obtain 
instructions for use.

A SIM card is used as a means for user identification: the data stored on the SIM 
card is read, and if valid, you are allowed to connect to the Internet and intranets. 
The SIM card is provided by the wireless provider.

Accounting data, such as used access time and/or transferred data, is passed from 
the network on to the wireless provider for billing purposes. Accounting begins 
when the wireless station is authenticated and ends when the wireless station 
logs off.

Note: The actual invoice for services from your wireless provider may vary, 
depending upon network features, rounding-off for billing, taxes and so 
forth.

Security in WLAN
Security issues should always be carefully considered to ensure the secure 
transmission of data in both wired and wireless LANs. In current wireless systems, 
for example, WLAN access points need to authenticate wireless stations to 

Figure 2 - Ad hoc network
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Introduction
prevent unauthorized access to the network. Authentication is a service that 
confirms the identity of an entity, such as a user or a computer, or confirms the 
origin of a transmitted message.

The Nokia D311 PC card supports the Wired Equivalent Privacy (WEP) protocol, 
which offers basic protection in WLAN. The WEP protocol utilizes the RC4 
algorithm with an up to 152-bit secret key, which encrypts data before it is 
transmitted over radio waves. When the wireless stations in a WLAN wish to 
communicate using WEP, they must have the same WEP key in possession. 

The Nokia D311 PC card is also compatible with leading Virtual Private Network 
(VPN) clients over GPRS and WLAN. VPN is recommended for more secure network 
access. 

The Nokia D311 PC card is equipped with an integrated smart card reader. SIM 
cards and smart card readers provide a tool for managing secure user 
authentication in a WLAN. SIM cards also provide an easy way for users to carry an 
authentication device with them. On a SIM card users can store important 
information, such as WEP keys and network profiles.

The smart card reader reads the data stored on the computer chip and sends it to 
the network for processing. The SIM card is protected by a PIN code; to access the 
contents of the SIM card, you need to enter the correct PIN code.

Warning: Keep all SIM cards out of reach of small children. Please refer to 
the Data Security document found on the product CD-ROM for more 
information on security issues.

Antenna
Tip: TIPS ON EFFICIENT OPERATION: Your PC card has a built-in antenna. As 
with any other radio transmitting device, do not touch the antenna 
unnecessarily when the PC card is on. Contact with the antenna affects 
connection quality and may cause the PC card to operate at a higher power 
level than otherwise needed. Not touching the antenna area during a 
connection optimizes the antenna performance.

The Nokia D311 PC card antenna is inside an 
extension box. In this document antenna 
refers to the extension box and the antennas 
inside it.

Do not cover the antenna. Unauthorized 
antennas, modifications, or attachments 
could damage the PC card and may violate regulations governing radio devices.
9



Installation
Installation

There are some differences in the installation process between Windows 
operating systems. If the installation differs from the steps described below, 
follow the instructions on the screen.

Software for the Nokia D311 PC card requires 20 MB of free disk space.

Install the software
Note: Do not insert the PC card into your computer until the installation 
program instructs you to do so.

1 Exit all Windows applications and insert the CD-ROM containing the 
installation software into the CD-ROM drive of your computer.

2 If the CD-ROM does not launch automatically,  open Windows Explorer and 
locate the icon for your CD-ROM drive. Click on the icon to view the contents 
of the CD-ROM drive. 

3 Double-click on Start.exe.
4 Select the language for the CD-ROM and installation program and read 

through and accept the Nokia license agreement. If you do not accept the 
license agreement, you cannot use the CD-ROM.

5 The main screen of the CD-ROM opens. Click Install to start the installation.
6 The Welcome page of the installation wizard opens. Click Next to continue.
7 Read through and accept the Nokia license agreement. If you do not accept the 

license agreement, you cannot use the software and the installation procedure 
stops. Click I Accept to accept the license agreement.

8 Select the destination folder for the software. The default folder is C:\Program 
Files\Nokia\Nokia D311 PC card. If you want to install the software in another 
drive or folder, click Browse. When you have selected the correct destination 
folder, click Next.

Note: You cannot install the Nokia D311 PC card software on a 
network drive.

9 Select the type of installation you want. The Administrator option is for system 
administrators only. Custom allows you to choose the individual software 
components to be installed, and is recommended for advanced users. Typical 
installs the most common software components. This option is recommended 
10



Installation
for most users. When you have selected the desired type of installation, 
click Next.

10 Check the installation settings. To accept them, click Next. To change the 
settings, click Back, make the changes, and then click Next. The installation 
program starts copying the files.

11 When the installation program prompts you to insert the PC card, insert it 
firmly into the PC card slot of your computer as shown in Figure 3. Note that 
there is a gap between the protruding extension box and the computer. Do not 
use excess force when inserting the card.

In the Windows 2000 operating system you are informed that no digital 
signature was found. Click Yes in each dialog box to continue with the 
installation.

In Windows XP, the operating system opens Found New Hardware wizards. For 
each of these wizards, first select the option Install the software 
automatically, and then select Continue Anyway to continue with the 
installation.

12 The Completion page informs you when the installation is completed. Remove 
the CD-ROM from the CD-ROM drive and click Finish. You may need to restart 
your computer.

13 A dialog box asks if you want to create a network profile now. Remember that 
you can create and edit your own network profiles at any time. If you do not 
want to create a profile, click No and the installation procedure is completed. 
If you want to create a profile, click Yes and the Welcome window of the 
profile wizard opens. See “Create new profiles” on page 21 for more 
information.

Figure 3 - Inserting the PC card
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Installation
Note: If you want other applications to be able to use the smart card reader 
of the Nokia D311 PC card, you need to install separately a PC/SC (Personal 
Computer Smart Card) compliant smart card driver on your computer. 
Install the smart card driver only if you want to use other applications or 
special types of smart cards with the smart card reader of the Nokia D311 
PC card. To install the driver, select Custom as the installation type (see step 
7 above) and select the PC/SC smart card driver component. In the Windows 
98 SE and Me operating systems you must have the Microsoft Smart Card 
Base Components 1.0 or later installed.

Modify the installation
You can alter the installation of the Nokia D311 PC card by adding or removing 
components, for example.

1 Exit all Windows applications and insert the CD-ROM containing the 
installation software into the CD-ROM drive of your computer.

2 If the CD-ROM does not launch automatically,  open Windows Explorer and 
locate the icon for your CD-ROM drive. Click on the icon to view the contents 
of the CD-ROM drive.

3 Double-click on Start.exe.
4 Select the language for the CD-ROM and installation program and read 

through and accept the Nokia license agreement. If you do not accept the 
license agreement, you cannot use the CD-ROM.

5 The main screen of the CD-ROM opens. Click Install to start the installation.
6 When the Welcome page of the installation maintenance program opens, 

choose from the following options:
Modify – You can install new components or remove existing ones.

Update – You can update the installed components and network profiles.

Uninstall – You can remove the Nokia D311 PC card program files and drivers 
from your computer.

When you have selected the option, click Next.

7 The selected wizard opens. Make the changes and click Next to continue.
8 Check the settings. To accept them, click Next. To change the settings, click 

Back, make the changes, and then click Next.
9 The modification starts. The Completion page informs you when the 

modification is completed. Click Finish.
12



Installation
Uninstall the Nokia D311 PC card software
Important: Before you uninstall the Nokia D311 PC card software, you 
must first stop the PC card and then remove it from the PC card slot of the 
computer. See “Remove the PC card” on page 18 for more information.

Close all dialog boxes in the user interface before you uninstall the Nokia D311 PC 
card.

To uninstall the Nokia D311 PC card software:
1 From the Start menu, select Settings and then click Control Panel. Click Add/

Remove Programs.
2 From the list of programs, select Nokia D311 PC card and click Add/Remove.
3 The Welcome page of the uninstall wizard opens. If you do not want profiles 

and settings configured on the Settings page removed, select the Keep all 
profiles and other settings check box. If you want to save all data relating to 
the SMS application, for example text and picture messages you have sent or 
received, select the Keep all data from the SMS application check box.
 Click Next to continue.

4 Check the uninstall settings. To accept them, click Next. To change the 
settings, click Back, make the changes, and then click Next. 

5 The uninstall program begins. The Completion page informs you when the 
uninstallation is completed. Click Finish.
13



Getting started
Getting started

With the Nokia D311 PC card you can:

• establish a General Packet Radio Service (GPRS) connection where 
information is sent in short bursts of data over the cellular network. The 
benefit of sending data in packets is that the network is occupied only when 
sending or receiving data. GPRS is ideal for applications which transmit data in 
short bursts, such as Web browsers. The data rate can be up to 40.2 Kbit/s. You 
need to subscribe to the GPRS service.

• connect to a GSM network where you can send and receive text and picture 
messages. You can also connect to the Internet or your e-mail by making a 
data call, which enables data transmission rates of up to 14.4 Kbit/s. You can 
make GSM data calls if your network supports data calls and you have 
subscribed to this service. 

• connect to a Wireless Local Area Network (WLAN) and send and receive data 
like in a regular wired LAN. The data rate in WLAN can be up to 11 Mbit/s.

Connect to a network
To be able to connect to a network you need a network profile. Easy connection 
profile with predefined settings is automatically created during software 
installation. This profile enables network access without your needing to 
configure any settings.

If you want to create a profile yourself, see “Create new profiles” on page 21 for 
more information.

You need a SIM card to be able to establish a GSM or GPRS connection.

To create a network connection:
1 Slide the SIM card into the smart card slot of the Nokia 

D311 PC card. Make sure that the metal contacts of 
the SIM card are facing down and that the bevelled 
corner is on the right.
Note: Insert the SIM card into the slot until the edge 
with the bevelled corner can no longer be seen, but no 
further than that. 
Note that the PC card does not support 5 Volt SIM 
cards.
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2 Insert the PC card firmly into the PC card slot of the 
computer.

Note that there is a gap between the protruding 
extension box and the computer. Do not use excess 
force when inserting the card.

3 Switch on your computer.
4 If you are using a SIM card, enter the PIN code and 

click OK. You can enter the PIN code before logging on to a network. 
5 During the log on a dialog box opens in the top left-hand corner of the screen. 

To select the profile and connection type at this stage, click Select.
6 The Select Connection dialog box opens. See Figure 4. From the list of profiles 

open the profile and select the connection type you want to use.

WLAN – Connects you to a wireless local area network where you can send 
and receive data.

GSM – Allows you to make data calls if your network supports data calls and 
you have subscribed to this service.

GPRS – You can establish a GPRS connection and send packet data. You need 
to subscribe to the GPRS service.

OFF – Disconnects the PC card from the network and turns off all radios.

7 Click OK to establish a network connection.

Figure 4  - Select Connection dialog box
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Tip: You can access the Select Connection dialog box also by right-clicking 
the Nokia D311 PC card icon on the taskbar, or by opening the Profiles page 
of the Manager window and clicking Select. If the taskbar icon is not visible, 
see page 28 for more information.

Tip: You can manage network connections also by using the Nokia D311 PC 
card icon on the taskbar. Right-click the icon and click Connect to connect 
to SIM services. To make a data call, click Dial, and to send packet data, click 
Activate. See “Connection status indicators” below for more information. If 
the taskbar icon is not visible, see page 28 for more information.

Warning: Do not use the PC card when wireless equipment use is prohibited 
or when it may cause interference or danger.

Connection status indicators
Taskbar icons and icons on the Profiles page indicate the status of the network 
connection.

Ready for data call – You have established a connection to a GSM network 
and can send and receive text messages. To access the Internet or your e-mail 
by using GSM data services, you need to make a data call. Click Dial to make 
a data call.

The use of GSM data services requires that your network supports data calls 
and that you have subscribed to this service. For more information, contact 
your wireless provider.

Data call to [phone number] – GSM data call is active. To finish the call, click 
End Call.

Ready to activate GPRS – You have established a connection to a GSM 
network that supports packet data sending (GPRS). You can send and receive 
text messages. To access the Internet or your e-mail by using GPRS, you need 
to establish a GPRS connection. Click Activate to establish a GPRS 
connection.

You need to subscribe to the GPRS service. For availability and subscription to 
packet data services, please contact your wireless provider.

GPRS active – GPRS connection is now active. To end the connection, click 
Deactivate.

Linked to (access point name) – You have established a connection to a 
WLAN access point. 

To connect to the SIM services, click Connect. The Connect button is 
activated only when the wireless station has detected a service in the 
network, otherwise the button remains inactive.
16
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Connected to SIM services – You have established a connection to SIM 
services. To end the connection, click Disconnect.

Before you can take advantage of the SIM services, you must subscribe to 
these services from your wireless provider and obtain instructions for use.

Ad hoc network – You have either established or joined an ad hoc network.

No network – You have selected Off as a connection type and are not 
connected to any network.

Set up and join ad hoc networks
Ad hoc networks allow wireless stations to communicate directly with each other 
without any WLAN access points. The stations can, for instance, share folders. One 
user creates the ad hoc network and other users then join the network.

See “Wireless Local Area Network (WLAN)” on page 6 for more information on ad 
hoc networks.

To connect to an ad hoc network:
1 On the Profiles page, select the General tab and click Select.
2 The Select Connection dialog box opens. Open the Easy connection profile 

and select the WLAN (ad hoc) connection type. Click OK.
3 If you are starting an ad hoc network, type the network name. If you are joining 

a network, select the network name from the list box. Click OK.

Tip: Create your own profile for ad hoc networking with the profile wizard if 
you use the ad hoc operating mode frequently. This saves you from having to 
select a network each time and allows for quicker access. See “Create new 
profiles” on page 21 for more information.

End network connections
Closing the Monitor or Manager window does not quit the program or end an 
existing network connection. To end a connection, select the connection type Off 
for a profile. See Figure 4 on page 15.

You can end the network connection also by stopping and removing the PC card.

To power off the PC card, you have to remove it from the PC card slot.
17
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Remove the PC card
You should always stop the PC card before removing it from the PC card slot of 
your computer. To stop the card, right-click the Nokia D311 PC card icon on the 
taskbar and select the option Stop card. If the taskbar icon is not visible, see 
page 28 for more information.

Important: The Windows 98 Second Edition operating system stops all PC 
cards when a new PC card is inserted into the computer. If you insert 
another PC card into your computer, make sure that you first stop the Nokia 
D311 PC card and remove it from the PC card slot. Otherwise you may lose 
the network connection, which may result in loss of data.
18
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Nokia D311 PC card features

The Manager and Monitor window
The user interface of the Nokia D311 PC card consists of the Monitor window and 
the Manager window. 

The Manager window is the main user interface of the Nokia D311 PC card. You 
can access the Manager window by right-clicking the Nokia D311 PC card icon on 
the taskbar and by selecting Manager window from the shortcut menu. If the 
taskbar icon is not visible, see page 28 for more information.

The Manager window consists of the following pages: Profiles, Settings, and Tools. 
The Administrator page is used by system administrators. The number of pages 
may vary depending on which pages were selected during the installation. You 
can view the different pages by clicking the icons on the icon bar on the left.

The Manager window is used for managing profiles, configuring settings, and 
viewing network status.

Figure 5 - Manager window
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Use the Monitor window
The Monitor window is a small window displaying information on the current 
network connection. The following information is available in the Monitor 
window: connection type, amount of sent and received data, duration of the 
connection, signal strength or WLAN connection quality, and data flow.

To open the Monitor window, right-click the Nokia D311 PC card icon on the 
taskbar and select Monitor window. If the taskbar icon is not visible, see page 28 
for more information. If you want the Monitor window to open automatically 
each time the PC card is inserted, go to the Settings page, General tab. Select the 
Open Monitor window automatically option.

The Monitor window displays both the amount of sent and received data (data 
counter), and the duration of the active connection (connection counter). Click on 
the data counter to display the connection timer, and click on the connection 
counter to display the data counter.

Note: The actual invoice for calls and services from your wireless provider 
may vary, depending upon network features, rounding-off for billing, taxes 
and so forth.

The signal strength indicator shows the strength and quality of the radio signal 
between the PC card and a GSM base station at your current location. In WLAN, 
the indicator shows the quality of the radio signal between a PC card and a WLAN 
access point. Remember that the strength of the radio signal is affected by 
distance and obstacles. The data flow indicator shows the relative speed at which 
data is transferred.

Profiles page
A profile is a group of network-specific and Windows networking settings. Profiles 
enable easy transfer from one network to another without having to remember all 
the different settings. 

On the Profiles page you can create, modify, or delete a profile. Profiles can be 
saved to and opened from a file. You can also send a profile as text message. 
Profiles are stored on your hard disk or a SIM card.

Figure 6 - Monitor window
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A default profile with pre-defined settings is automatically created during the 
software installation process. Note that this profile cannot be edited, deleted, 
exported, or sent as a text message.

Select a profile and connection type
You need to select a network profile and connection type suitable for the network 
in which you want the PC card to operate.

1 On the Profiles page, select the General tab and click Select.
2 The Select Connection dialog box opens. See Figure 4 on page 15. From the 

list of profiles open the profile and select the connection type you want to use. 
Click OK.
If you selected WLAN connection type, you are now connected to a WLAN 
access point. To connect to SIM services, click Connect. 

If you selected GSM or GPRS connection type, you are connected to a GSM 
network, but to make a data call you have to click Dial, or to send packet data 
you have to click Activate. 

If you set the connection type to Off, the PC card is disconnected from the 
network. See “Connection status indicators” on page 16 for a detailed 
description of the various network statuses.

Tip: You can access the Select Connection dialog box also by right-clicking 
the Nokia D311 PC card icon on the taskbar. If the taskbar icon is not visible, 
see page 28 for more information.

Tip: You can manage network connections also by using the Nokia D311 PC 
card icon on the taskbar. Right-click the icon and click Connect to connect 
to SIM services. To make a data call, click Dial, and to send packet data, click 
Activate. See “Connection status indicators” on page 16 for more 
information. If the taskbar icon is not visible, see page 28 for more 
information.

Note: When you change a profile or connection type, you may need to 
change your Web browser’s proxy settings or domain settings for Windows 
networking.  Refer to the documentation for your specific operting system 
for more information.

Create new profiles
By creating different profiles for different networks, you can easily switch from 
one network to another without having to memorize the network settings.

1 On the Profiles page, select the Modify tab and click New.
2 The Welcome page of the profile wizard opens. To continue, click Next.
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3 Give a name to the new profile. The name can consist of a maximum of 30 
alphanumeric characters. 
Select the appropriate connection type. You can use more than one connection 
type with each profile. Click Next.

4 If you selected WLAN connection type, you have to specify the following 
WLAN options:
Operating mode – Select one of the two available operating modes. In the 
infrastructure mode, computers can communicate with each other and with 
wired LAN stations through a WLAN access point. In the ad hoc mode, 
computers can send and receive data directly with each other. No access point 
is needed. See “Wireless Local Area Network (WLAN)” on page 6 for more 
information. 

Network name – Type the network name as defined by the system 
administrator, or select one from the list box. In the ad hoc operating mode, the 
users themselves name the WLAN. The network name can consist of a 
maximum of 32 alphanumeric characters. By default, the network name is 
case-sensitive.

To continue, click Next.

5 If your local area network does not have a DHCP (Dynamic Host Configuration 
Protocol) server, which would assign an IP address for the PC card 
automatically, you need to specify the IP address, subnet mask, and default 
gateway settings manually. Ask your system administrator for the correct 
values.

Note: Make sure that the Manage TCP/IP properties together with 
profiles check box is selected (Settings page, General tab). If this check 
box is not selected, the TCP/IP settings are managed by network settings, 
which can be configured in the Control Panel of your computer.

6 If you selected GSM connection type, you have to specify the
following settings: 
GSM connection method – Select Analog if you are using a modem 
connection. If you are using an ISDN connection, select ISDN V. 110 or ISDN 
V. 120, depending on which ISDN standard your Internet service provider 
supports.

GSM connection speed – Depending on the network, select the correct data 
transmission rate: 9.6 Kbit/s or 14.4 Kbit/s. See “GSM properties” on page 25 
for more information on data transmission rates.

Note: The use of GSM data services requires that your network supports 
data calls and that you have subscribed to this service. Contact your 
wireless provider for more information.
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Dial-up connection – Select a dial-up connection from the list or create a new 
dial-up connection. Dial-up networking connects you to remote networks 
using your PC card as a modem or ISDN adapter. 

To continue, click Next.

7 If you selected GPRS connection type, you have to specify the GPRS access 
point name. You obtain the access point name from your wireless provider. If 
you select Use access point provided by network, the network will connect 
you to an available GPRS access point automatically if this feature is 
supported by the network. In some cases you may need to specify further dial-
up networking settings. For more information, please contact your wireless 
provider or refer to the online help of your operating system. 
Click Next.

8 The Completion page of the profile wizard informs you when the creation of a 
new profile is completed. Click Finish.

To take the new profile into use, you must first select it. See “Select a profile and 
connection type” on page 21 for more information.

Edit profiles
1 On the Profiles page, select the Modify tab and then select a profile from the 

list. Click Edit.
2 Make the necessary changes and click OK. Profile-specific settings that can be 

modified are explained on pages 28 – 32.

The Easy connection profile and profiles that are saved to a SIM card cannot be 
edited.

Note: It is recommended that you do not edit a profile that is currently in 
use.

WLAN properties: General tab

Use WLAN connection with this profile
Select this check box if you want to use the profile for accessing a WLAN.

Operating mode
Select one of the two available operating modes. In the infrastructure mode, 
computers can communicate with each other and with wired LAN stations 
through a WLAN access point. In the ad hoc mode, computers can send and 
receive data directly with each other. No access point is needed. See “Wireless 
Local Area Network (WLAN)” on page 6 for more information. 

Network name
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Network name is the name of the WLAN as defined by the system administrator. In 
the ad hoc operating mode, the users themselves name the WLAN. You can add a 
new network name to the list, edit an existing one, or delete a name. The network 
name can contain a maximum of 32 characters, and is case-sensitive by default.

Configure settings manually
There are a number of advanced WLAN settings (fragmentation threshold, listen 
interval, RTS threshold, security policy, etc.), which are configured automatically. 
Select this check box and click Advanced if you want to specify a new value 
manually.

Important: Do not change the settings manually unless you are sure how 
each setting affects system performance. System performance may drop 
dramatically if automatic settings are not used.

By default, you are automatically allocated an available radio frequency channel 
without needing to specify one. You can, however, also select a particular channel 
yourself: select Channel from the list of properties, clear the Automatic check 
box and select a channel from the list. Make sure that the Nokia D311 PC card and 
the WLAN access point are using the same channel.

Warning: Using the Nokia D311 PC card in some countries or regions may 
be illegal. Consult local authorities on the regulations concerning the use of 
the Nokia D311 PC card.

Use WEP security
Select this check box and click WEP Keys if you want to use Wired Equivalent 
Privacy (WEP) keys for protecting the information transmitted in WLAN.

 See “WEP security” on page 37 for more information.

WLAN properties: TCP/IP tab
Automated IP settings (DHCP) are enabled by default. When using DHCP (Dynamic 
Host Configuration Protocol), you do not have to modify your IP settings when you 
change your location.

If your local area network does not have a DHCP server, which would assign an IP 
address for the PC card automatically, you need to specify the IP addresses 
manually. The advanced TCP/IP settings can also be specified and configured 
manually. Ask your system administrator for the correct values.

WLAN properties: SIM Services tab

Use SIM services with this profile
SIM services refers to a service that enables you to access the Internet via your 
wireless provider’s own public network. Your wireless provider may, for example, 
offer you the possibility of checking data from your company intranet, send and 
receive e-mail, and save documents. SIM services are usually available in public 
24



Nokia D311 PC card features
places such as hotels, airports, railway stations, business centers, and corporate 
buildings.

A SIM card is used as a means for user identification and billing. The SIM card is 
provided by the wireless provider.

Note: Before you can take advantage of SIM services, you must subscribe to 
these services from your wireless provider and obtain instructions for use.

Service provider domain
Type the domain name, as in company.com. You cannot connect to SIM services 
without specifying the domain name. You obtain the name from your wireless 
provider.

Prompt when a SIM service is detected
When you are connected to a WLAN and a SIM service is detected, you are asked 
whether you want to get connected. Once you have confirmed that you want to 
get connected, you will be authenticated to the service.

Enable advanced connection controlling
Your wireless station sends keep-alive signals on a periodic basis to an access 
controller in order to check the validity of the connection. If the wireless station 
receives no response, the connection is ended automatically. If you select this 
check box, your wireless station and the access controller can exchange 
additional signals, which enables a quicker detection of lost connection.

GSM properties

Note: The use of GSM data services requires that your network support data 
calls and that you have subscribed to this service. Contact your wireless 
provider for more information.

Remember to select the Nokia D311 PC card as the modem in each data and fax 
communications application. Note that the modem settings have to be separately 
changed in each application.

Use GSM connection with this profile
Select this check box if you want to use the profile for making data calls. When 
you have an active data call, you can access the Internet and send and receive e-
mail, for example.

GSM connection method
Select the appropriate data call type. Select Analog if you are using a modem 
connection. If you are using a ISDN connection, select ISDN V.110 or ISDN 
V.120, depending on which ISDN standard your wireless provider supports. 
Contact your wireless provider for more information on which remote ISDN 
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connections are supported.

GSM connection speed
Select the data transmission speed. The number of time slots used is indicated in 
parenthesis.

You can see the receiving and sending data transmission rates on the Profiles 
page under the Operating information area.

Dial-up connection
Select a dial-up connection from the list or create a new dial-up connection using 
the Windows dial-up wizard. Dial-up networking connects you to remote 
networks using your PC card as a modem or ISDN adapter.

GPRS properties

Use GPRS connection with this profile
Select this check box if you want to use the profile for sending and receiving 
packet data.

Use access point provided by network
Select this if you want the network to select a GPRS access point for you. The 
network will connect you to an available GPRS access point automatically if this 
feature is supported by the network.

Specify access point name manually
If you obtain the GPRS access point name from your wireless provider, select this 
check box and type the name. An access point name is needed to establish a 
connection to a GPRS network.

Remove profiles
On the Profiles page, select the Modify tab and then select a profile from the list. 
Click Delete.

The Easy connection profile cannot be deleted. 

9.6 KBIT/S
(1+1)

The standard GSM data transmission rate.

14.4 KBIT/S
(1+1)

Can be used if it is supported by the network. Do not use this 
option unless you are sure your network supports it.
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Profiles that are stored on a SIM card can only be removed by the system 
administrator.

Import and export profiles
On the Profiles page, select the Modify tab and then click Import. Select the 
folder from which you want to import a profile.

Similarly, you can save a profile in a folder. Click Export, and select the folder 
where you want to save the profile.

The Easy connection profile cannot be exported. 

The system administrator can import profiles from and export profiles to a SIM 
card.

Send a profile as a text message
Make sure you have either a GSM or GPRS connection type selected. You cannot 
send or receive text messages when connected to a WLAN.

The Easy connection profile cannot be sent as a text message. 

1 On the Profiles page, select the Modify tab and select the profile you want to 
send as a text message. Click Send.

2 The Send Profile Via SMS dialog box opens. Type the phone number of the 
recipient in the box or click Select and select it from the list of contacts stored 
on your SIM card.
The dial-up connection that has been specified for the profile is sent 
automatically with the profile. Dial-up connections are needed when you 
want to make a data call (GSM connection) or send packet data (GPRS 
connection).

3 Click Send to send the text message.

Note: A profile may be made up of several text messages. Therefore, 
sending one profile may cost more than sending one text message.

Settings page
On the Settings page you can set properties that are common for all profiles. These 
settings will remain unchanged even when you switch to using another profile or 
connection type. The GSM and WLAN settings apply to corresponding connection 
types only.
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For the changes to take effect, click the Apply button. If you have made changes 
to the settings but have not yet clicked Apply and wish to restore the previous 
settings, click Restore.

General settings (General tab)
Manage TCP/IP properties together with profiles
By default, TCP/IP settings are managed as defined in each profile. 

When the Manage TCP/IP properties together with profiles check box is 
cleared, profiles will be activated without TCP/IP settings. You can change the 
settings manually in the Control Panel of your computer.

Do not establish network connection automatically
When this check box is selected, the Select Connection dialog box opens 
automatically when you start your computer or insert the PC card. In the dialog 
box you can select the connection type you want to use. The default connection 
type is Off. See Figure 4 on page 15.

If you clear this check box, every time you start your computer or insert the PC 
card, the connection that was last used is established automatically.

Warning: It is recommended that you have this check box selected. It can 
prevent you from accidentally establishing a network connection in areas 
where the use of wireless device is prohibited or when it may cause 
interference or danger.

Alert when connection status changes
If this check box is selected, you hear an alert tone every time the status of the 
network connection changes.

Open Monitor window automatically
When you insert the Nokia D311 PC card into your computer, a small icon appears 
on the taskbar. By right-clicking this icon a shortcut menu opens, and from there 
you can access the Monitor window. If, however, you want the Monitor window to 
open automatically each time the card is inserted, select the Open Monitor 
window automatically option.

Show icon on taskbar
If you select Show icon on taskbar, a small Nokia D311 PC card icon will be 
displayed on the taskbar whenever the PC card is inserted. If you clear this check 
box, you can access the user interface of the Nokia D311 PC card from the Start 
menu (Start, Programs, Nokia, Nokia D311 PC card).

Exit program when card is removed
If this check box is selected, you automatically exit the program when you remove 
the PC card from the wireless station.
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Basic GSM settings (GSM tab)
Automatic system selection
The GSM network to which your PC card is connected can be selected either 
manually or automatically.

If the Automatic system selection check box is selected, the PC card 
automatically selects one of the systems available in your area. Outside of the 
home network area, the PC card will select one of the systems that have a roaming 
agreement with your home network.

To select a network manually, clear the Automatic system selection check box 
and click Search Systems. Select a system from the list of available systems and 
click OK. If the PC card cannot reach the selected network or loses contact with it, 
you are prompted to select another system.

Note: If you select any other than your home network, this network must 
have a roaming agreement with your home network operator.

Voice mailbox number
Type your voice mailbox number in this box. You obtain this number from your 
wireless provider.

Display cell info 
You can set the PC card to indicate when it is used in a cellular network based on 
Micro Cellular Network (MCN) technology.

Display incoming calls
When this check box is selected, you will get a notification when you have a call 
(data, fax) coming in.

Advanced GSM settings (GSM tab)
A number of advanced GSM settings are network services: before you can benefit 
from these services, you must subscribe to them from your wireless provider and 
obtain instructions on their use.

To access these settings, select the Settings page and GSM tab. Click Advanced 
Settings.

Call Forwarding
Call forwarding is a network service that allows you to direct incoming voice, data 
and fax calls to, for example, your voice mailbox number. 

Activate call forwarding:
1 On the Settings page, select the GSM tab and click Advanced Settings.
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2 The Advanced GSM Settings dialog box opens. Select the Call Forwarding 
tab.

3 From the Call type list, select the call type you want to be forwarded (voice, 
data or fax).

4 Click Check Status to check whether the call forwarding is activated or not. To 
set the forwarding setting on, click Change.

5 Select where you want to forward your incoming calls and type the phone 
number. Click OK.

6 Click OK to apply the settings and to close the dialog box.

To cancel all the active call forwarding at once, click Cancel All Forwarding. 

To cancel only one call type forwarding, click Change and select Deactivate in the 
Forward to list.

Note: Make sure you have either the GSM or GPRS connection type 
selected when setting call forwarding or checking the status. When 
connected to WLAN, you cannot configure these settings.

Call Restrictions
Call restriction is a network service that allows you to restrict incoming and 
outgoing calls so that calls cannot be received or made. 

Activating call restrictions or changing the restriction settings requires the 
restriction password, which you obtain from your wireless provider. See “To 
change access codes:” on page 33 for information on how to change the 
restriction password.

To set call restriction options:
1 On the Settings page, select the GSM tab and click Advanced Settings.
2 The Advanced GSM Settings dialog box opens. Select the Call Restrictions 

tab.
3 From the Call type list, select the call type you want to restrict (voice, data, fax, 

or messages).
4 Click Check Status to ask the network for the call restriction status. To set a 

restriction setting on, click Activate.
5 Type your restriction password and click OK.
6 Click OK to apply the settings and to close the dialog box.

To disable all call restrictions, click Cancel All Restrictions. To disable only one 
call type restriction, click Deactivate.

Note: Make sure you have either the GSM or GPRS connection type 
selected when setting call restriction options or checking the status. When 
connected to WLAN, you cannot configure these settings.
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Messages
With the Nokia D311 PC card you can send and receive text and picture messages. 
See “Nokia Short Messaging” on page 41 for more information.

Any changes that you make to message settings affect the way in which your 
messages are sent and received. The availability of some of the settings depends 
on the wireless provider.

SMS application in use
Select the Short Message Service (SMS) application you want to use for sending 
and receiving messages. The Nokia D311 PC card includes the Nokia Short 
Messaging application.

Message center number
You need the message center number to send messages. You receive the number 
from your wireless provider.

Messages sent as
Text and picture messages are normally sent in text format, but it is possible to 
convert them into an alternative format (e-mail, fax, paging). To be able to receive 
a converted message, the recipient must have an appropriate device available, and 
the network must support this feature.

Message validity
If the recipient of a message cannot be reached within the set message validity 
period, the message is removed from the message center. If you select Maximum, 
the validity period is set to the maximum time allowed by the network.

Reply via same message center
Select this check box if you want to request the network to route the reply to your 
message via your own message center.

Delivery reports
Select this check box if you want to receive delivery reports on the messages you 
have sent.

Send long messages
If the Send long messages check box is selected, messages longer than 160 
characters are sent as concatenated messages. A concatenated message is 
received as one long message if the recipient’s device supports this function. If 
this option is not selected, messages longer than 160 characters are sent as 
several normal text messages.

Start SMS application when message is received
Select this check box if you want your SMS application, such as Nokia Short 
Messaging, to open automatically when you have received a message.
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Use GPRS as preferred SMS bearer
You can select whether messages will be sent using GPRS packet data whenever 
possible.

Sounds
If you want to be notified of an incoming call or message by a tone, select the 
Alert on incoming calls and messages check box. Type the name of the wav file 
in the appropriate text box or click the Browse button and select the file you want.

By clicking the arrow button you can listen to an example of the selected wav file.

WLAN settings (WLAN tab)
Enable power saving
The Nokia D311 PC card is equipped with a power saving option which controls 
the amount of power it consumes during operation, which may prolong the life of 
your computer’s battery.

If you select the Enable power saving check box, the Nokia D311 PC card goes 
into sleep mode and powers up at regular intervals to check for incoming and 
outgoing data. If data is detected at the WLAN access point during these checks,  
the Nokia D311 PC card then powers up to send or receive the data.

Note: The speed of communication decreases when the power saving 
option is used. 

Note: The power saving option may not be compatible with WLAN access 
points that are not Wi-Fi (Wireless Fidelity) approved. Do not use power 
saving with such access points.

Case-sensitive network names
By default, the name of the WLAN is case-sensitive. If you do not want the 
network names to be case-sensitive, clear this check box.

Renew DHCP automatically when needed
If the network has a DHCP server and you want the system to allocate your IP 
addresses automatically, select the Renew DHCP automatically when needed 
check box. You can also renew your IP address whenever you want by clicking the 
Renew DHCP Now button.

Security settings (Security tab)
You can set various access codes and protect your PC card and SIM card against 
unauthorized use.

Codes can only include digits from 0 to 9.
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PIN code request
The PIN (Personal Identification Number) code is usually supplied with the SIM 
card. It protects your SIM card against unauthorized use. If you set the PIN code 
request on, you are asked for the PIN code when you start the Nokia D311 PC card 
program or insert the PC card, provided that you have inserted a SIM card into the 
PC card. Click the Change button to change the status. 

Note: Some SIM cards do not allow turning off the PIN code request.

If you enter an incorrect PIN code three times in a row, the code is blocked and the 
SIM card cannot be used. To change a blocked PIN code, you need a PUK (PIN 
Unblocking Key) code. PUK is an 8-digit code supplied with the SIM card.

Security code request
The security code protects your PC card against unauthorized use, and is supplied 
with the PC card. The preset code is 12345. Change the preset code and keep the 
new code secret and in a safe place separate from your PC card. 

If you key in an incorrect security code five times in succession, the PC card will 
not accept the correct code for the next five minutes.

To change access codes:
You can change the PIN code, security code, and restriction password. Note that 
changing the restriction password requires that the call restriction service is 
activated for your SIM card.

1 On the Settings page, select the Security tab and click Change Access Code.
2 The Change Access Code dialog box opens. Select from the list the access code 

you want to change.
3 In the Current code box, type the code used presently. 
4 In the New code box, type the new code.

Note: The access codes may only include numbers from 0 to 9. The PIN 
code length must be at least four and no more than eight digits. The 
length of the security code is always five digits and the length of the 
restriction password is four digits.

5 In the Confirm new code box, type the new code again.
6 Click OK to apply the changes and to close the dialog box.

Tools page
On the Tools page you find, for example, detailed information on the network 
connections, you can run a series of fault diagnosis tests, and you can create 
personal WEP keys.
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Counters
On the Counters tab you can view detailed information on your network 
connections, including the number of connections, their duration, and amount of 
data transmitted. You can also see how many text and picture messages you have 
sent and received.

You can select a pre-defined time period for which information is shown, or set 
the start and end time yourself.

You can save the information to an html or a csv file by clicking the Report button. 
To clear all counters, click Clear.

Note: The actual invoice for calls and services from your wireless provider 
may vary, depending upon network features, rounding-off for billing, taxes 
and so forth.

View connection history
On the History tab you can monitor various connection events. You can select the 
type of network and the level of detail to be reported.

You can save the information to an html or a csv file by clicking the Report button. 
Note that only information that is currently on display is saved to a file. The file 
can be useful if you need, for example, to contact technical support in problem 
situations. 

To remove all history information, click Clear.

Diagnose faults
On the Diagnostics tab you can run a series of fault diagnosis tests to ensure that 
the PC card and the software are operating correctly. If you encounter problems in 
accessing a network, for example, the tests can help to identify the source of the 
problem. 

The tests check that the software files have not been modified, the settings 
configured both on the Profiles and Settings pages are valid and do not conflict, 
and all drivers have been installed correctly. If the card does not pass the test, you 
are given advice on how to proceed.

To start the fault diagnosis test, click Start.

You can save the test result to a text file by clicking the Report button. The text 
file can be useful if you need, for example, to contact technical support in problem 
situations. Note that the content of this file is in English only.
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Manage personal WEP keys
Personal Wired Equivalent Privacy (WEP) keys are used for authenticating the user 
in a WLAN. Personal keys are usually created by the system administrator, who 
can store them on SIM cards and then distribute them to the users. Personal keys 
can also be saved to a file. Since personal keys are not network specific, they 
cannot be saved together with profiles. They can, however, be saved to a file and 
used independently from profiles.

Personal WEP keys can be used only with the infrastructure operating mode, 
provided that the WLAN access point supports the keys. Ad hoc networks use 
shared WEP keys only.

See “Create and edit personal WEP keys” on page 40 for more information.

Administrator page
The Administrator page is meant for system administrators and is not installed as 
part of the normal installation procedure. On the Administrator page, the system 
administrator can view detailed information on the network connections and save 
important data on a SIM card. The administrator can create installation disks that 
include relevant network profiles and settings, and that then can be distributed to 
end users within a corporation, for example.

Monitor information on WLAN
On the WLAN tab you can view general information on various elements of a 
WLAN. Depending on the type of access point in use, the details displayed can 
include network name, data rate, channel, signal strength, and IP address.

Select from the following items:

Access points – In the infrastructure operating mode, shows which WLAN access 
points are currently in range and available.

Networks – Shows all the wireless local area networks that can be accessed with 
the PC card.

Wireless stations – In the ad hoc operating mode, the names of the other 
computers connected to the ad hoc network are displayed. Note that only the 
names of those computers that are using the Nokia D311 PC card are shown.

To update the information on display, click Refresh.
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View WLAN statistics
On the Statistics tab you can view detailed information on the connection 
between the Nokia D311 PC card and the WLAN access point to which you are 
linked. Both graphical and numeric statistics are given for the following 
properties: connection quality, received signal strength (RSSI), noise floor, signal 
to noise ratio (SNR), Tx retry rate, and data flow.

If you want to save the information to a text file, click Start Logging.

Create installation disks
The system administrator can create installation disks that contain all the 
software and necessary settings needed for accessing networks. The custom 
installation package fits on a compact disk but can also be saved on a hard disk.

The installation disk can be used for distributing profiles. All the desired settings 
and profiles can be copied to the installation disk, and the end user does not have 
to configure settings in order to be able to connect to a network. 

To generate an installation disk:
1 On the Administrator page, select the Installation Disk tab. Select from the 

following options:
Profiles available – The list contains the names of all the profiles found in the 
system registry. Select the profiles that you want to include in the installation 
package.

Allow editing of selected profiles – The administrator can deny the editing of 
those profiles that are distributed with the installation disk. The user can 
create new profiles.

Include smart card driver – If you want other applications to be able to use the 
smart card reader of the Nokia D311 PC card, you need to install a PC/SC 
(Personal Computer Smart Card) compliant smart card driver. When this 
option is selected, the smart card reader can be used with other applications 
besides the Nokia D311 PC card, and with special types of smart cards. 

Include basic settings from Settings page – Certain settings that have been 
configured on the Settings page can be included in the installation package. 
These include all settings configured on the General tab, GSM tab (no 
advanced settings such as call forwarding), and WLAN tab. These settings are 
common for all profiles.

Create one file installation package – The installation package consists of only 
one executable file. It contains the necessary files and drivers, and is easier to 
distribute through e-mail, for example, than several separate files.

Include Administrator page – The entire Administrator page is included in the 
installation package.
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2 To start creating an installation disk with the selected profiles and options, 
click Create.

3 Select the destination folder and click OK.

Manage SIM card contents
The system administrator can store important information such as personal WEP 
keys and network profiles on a SIM card. The administrator can then give users 
SIM cards, which contain the necessary network settings and encryption keys for 
quick network access. 

Transferring files from the computer to the SIM card and vice versa is done by 
using a drag-and-drop operation or by using the Copy, Move, and Delete buttons 
on the SIM Card tab.

For the changes to take effect, click Apply. Note that the button is inactive if there 
is not enough free space on the SIM card. If you have made changes but wish to 
restore the previous state, click Restore.

Distribute profiles
The system administrator can create profiles and then distribute them to end 
users within a corporation. There are different ways for delivering profiles:

• Installation disks: the system administrator can create installation disks which 
contain all the software and necessary settings needed for accessing networks 
– including profiles. See “Create installation disks” on page 36.

• Network: profiles can be saved to a folder on a network drive from which the 
end user can import the profile. See “Import and export profiles” on page 27.

• SIM card: the system administrator can store profiles on SIM cards which can 
then be distributed to end users. See “Manage SIM card contents” above.

• Text messages: profiles can be distributed by sending a text message that 
includes a profile. See “Send a profile as a text message” on page 27.

WEP security
To increase the security of communication over the wireless local area network, 
the Nokia D311 PC card offers the Wired Equivalent Privacy (WEP) security 
feature. WEP uses the RC4 algorithm with an up to 152-bit key. The algorithm 
provides for security via two methods: authentication and encryption. 
Authentication is the means by which one wireless station is verified to have 
authorization to communicate with a second station in a given coverage area.
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In the infrastructure operating mode, authentication is established between a 
WLAN access point and each wireless station. If a wireless station receives a 
packet that has not been scrambled with a correct key, the packet is discarded. 
Encrypted messages can be opened by other PC cards only if they all use the same 
encryption key. In the ad hoc operating mode, authentication is established 
between each wireless station.

The level of security is dependent on the length of the key: the more bits there are 
in the key, the longer it takes to decrypt the information sent and the higher the 
level of security. 

WEP keys consist of a secret key and a 24-bit Initialization Vector. For example, 
the 128-bit WEP key has a 104-bit secret key that the user can set, and a 24-bit 
Initialization Vector that cannot be controlled by the user. Many manufacturers 
refer to this 128-bit key as a 128-bit key, whereas some refer to it as a 104-bit key 
(104+24). Both keys offer the same level of encryption and are therefore 
interchangeable.

Tip: Regardless of how the WEP keys have been named, all keys are 
compatible as long as their length is the same. For example, keys that are 40 
bits long, always consist of 5 alphanumeric characters or 10 hexadecimal 
characters.

The Nokia D311 PC card supports three key lengths: 40 (40+24), 128 (104+24), 
and 152 (128+24) bits. The 40-bit key is Wi-Fi (Wireless Fidelity) compatible.

There are two types of WEP keys: shared keys and personal keys.

Shared WEP keys
Shared WEP keys are shared by all wireless stations using the network or 
subnetwork; only stations that have the correct key can receive and decrypt data. 
The same key is loaded into the WLAN access point. Shared keys are usually 
created by system administrators, who distribute them to users.

Shared keys are network-specific, and each network can have a maximum of four 
different shared keys. A WLAN access point only transmits data using the active 
key, but can receive data from wireless stations using any of the four shared WEP 
keys.

Tip: If you have a profile that includes more than one network, it is 
recommended that you use the same shared WEP keys with all these 
networks.

Because the shared WEP keys are network-specific and user-independent, they 
can be saved in a file together with profiles. Users can import from a file or a SIM 
card profiles that include shared keys and that have been created by their system 
administrator.

Shared keys can be used as the only form of WEP security or used together with a 
personal key.
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Personal WEP keys
Each wireless station can have an individual, personal WEP key. Personal keys are 
used for providing additional security for wireless connections. They are usually 
created by system administrators, who distribute them to users. A WLAN access 
point uses a different key for each wireless station. 

There are two types of personal WEP keys, and the difference between the keys is 
the type of information that is used for identifying the user:

• Station-specific – Uses the MAC address of the PC card to identify the user.

• User-specific – Uses an identifier that the users can create themselves.

Unlike shared WEP keys, personal WEP keys are not network specific, and 
therefore cannot be saved together with profiles. They can, however, be saved to 
a file and used independently from profiles.

Personal WEP keys can be used only with the infrastructure operating mode. Ad 
hoc networks use shared WEP keys only.

Note: Not all WLAN access points support personal WEP keys. Ask your 
system administrator for more information.

Create and edit shared WEP keys
Shared WEP keys are usually created by a system administrator. 

In the infrastructure operating mode, make sure that the same shared WEP key is 
configured to the WLAN access point; if the access point and PC card are using 
incompatible keys, they cannot communicate. Contact your system administrator 
for details.

1 On the Profiles page, select the Modify tab. Select from the list the profile 
with which you want to use a shared WEP key. Click Edit. 

2 The Edit Profile dialog box opens. Select WLAN and General tab.
3 Select the Use WEP security check box and click WEP Keys.
4 Select from the four keys which one you want to modify. Click Edit.
5 Select the appropriate key length. Supported key lengths are 40, 128, and 152 

bits. Remember that the more bits there are in the key, the higher the level of 
security.
Type in the WEP key data in hexadecimal format. If you want to enter the WEP 
key in text form, type the text in the In text form box. You can copy and paste 
the text by using the CTRL+ C and CTRL+V key combinations respectively.

6 Click OK to save the shared WEP key.

To select which shared WEP key to use, select the key and click Activate. 

To empty the contents of the key, click Clear.
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Create and edit personal WEP keys
Personal WEP keys can be used only with the infrastructure operating mode. Ad 
hoc networks use shared WEP keys only. Make sure that the same personal WEP 
key is configured to the WLAN access point; if the access point and PC card are 
using incompatible keys, they cannot communicate with each other. Contact your 
system administrator for details.

1 Go to the Tools page and select the Personal Keys tab. Click New to create a 
new key, or click Edit to modify an existing one. 

2 Give the personal key a name. You can also include a further description of the 
key, such as the name of the network where the key is used.

3 Select the type of key you want to create: station-specific or user-specific. If 
you choose a station-specific key, the MAC address of the PC card is used for 
identifying the user. If you choose a user-specific key, you can choose the 
identifier yourself.

4 Select the appropriate key length. Supported key lengths are 40, 128, and 152 
bits. Remember that the more bits there are in the key, the higher the level of 
security. Click Generate. The system generates your personal key.
To enter the WEP key in text form, type the text in the In text form box. You 
can also copy and paste the text using the CTRL+ C and CTRL+V keys.

5 Click OK to save the WEP key.

Import and export personal WEP keys
Instead of creating a personal WEP key yourself, you can import from a folder a key 
created, for example, by your system administrator. You can export and save 
personal keys in folders. The system administrator can import personal WEP keys 
from a SIM card and export them to a SIM card.

1 On the Tools page, select the Personal Keys tab. Select the key you want to 
save to a file and click Export. To open a key from a file, click Import.

2 If you are exporting a personal WEP key, select the destination to which you 
want to save the key, and click Save. If you are importing a key, select the 
source from which you want to import the key and click Open. 

Select a personal WEP key
1 On the Profiles page, select the Modify tab. Select from the list the profile 

with which you want to use a personal WEP key. Click Edit. 
2 The Edit Profile dialog box opens. Select WLAN and General tab. 
3 Select the Use WEP security check box and click WEP Keys.
4 Select the Use a personal WEP key check box and select a key from the list. 
5 Click OK.
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Nokia Short Messaging

The Nokia Short Messaging application enables you to manage text and picture 
messages in a similar way that you manage e-mail: you can send and receive 
messages, reply to a message, and forward a message.

The sending and receiving of messages requires that the Short Message Service 
(SMS) is available in the GSM network you are using and it is activated for your 
SIM card. Contact your wireless provider for details.

Note: You cannot send or receive messages when connected to a WLAN.

Tip: You can access the Nokia Short Messaging application by right-
clicking the Nokia D311 PC card icon on the taskbar and by selecting SMS 
application from the shortcut menu. If the taskbar icon is not visible, see 
page 28 for more information.

The Nokia Short Messaging application consists of the following pages:

• The Inbox page contains the received messages.

 Received text message. If the message icon is green, you have not read the 
message.

 Received picture message.

 Message that you have forwarded to someone.

 Message to which you have replied.

 You have both replied to the message and forwarded it to someone.

 Received business card.

• The Outbox page contains messages that are being sent or waiting to be sent. 
If you write and send a new message when the PC card is not inserted in the 
wireless station, you are connected to WLAN, or the GSM or GPRS connection 
is lost, the unsent message is stored in Outbox. Outbox may contain several 
unsent messages, which are then sent when the PC card is inserted, or a proper 
network connection is established.
The messages can have the following statuses:

Sending –  The message is currently being sent.

Waiting – The message is waiting for sending to become possible.
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• The Delivery reports page contains information on the status of the messages 
you have sent. This is a network service to which you must subscribe before 
being able to use it.

Possible statuses for sent messages are:

Delivered – The message has been delivered to the recipient.

Pending – The message has not been delivered to the recipient yet. If the 
recipient of a message cannot be reached within the set message validity 
period, the message is removed from the message centre.

Failed – The message could not be delivered to the recipient (for example, the 
message center number was incorrect). The recipient was not reached within 
the set message validity period and the message was removed from the 
message center.

• The Sent messages page contains a copy of each sent message.

• The Contacts page enables you to manage contact information and business 
cards stored on the SIM card. You can create, edit, and delete contacts, and 
send business cards as text messages.

Text messages
Before you can send any text messages, you need to save your message center 
number. See “Configure message settings” on page 44 for more information.

Make sure you have either a GSM or GPRS connection type selected. You cannot 
send or receive messages when connected to WLAN.

Send text messages
1 Click  on the toolbar, or click New on the File menu. The Message Editor 

dialog box opens.
2 In the Message field, type the message. The character counter above the field 

shows how many characters you have left and in how many messages the text 
will be sent. 

Note: The standard length of a text message is 160 characters. 
Messages longer than this can be sent as several normal text messages 
or as one concatenated text message which is received as one long 
message if the recipient's device supports this function. You can select 
the Send long messages option on the Settings page of the Nokia D311 
PC card. See “Configure message settings” on page 44 for more 
information.
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You can attach a picture to the text message. See “Send picture messages” on 
page 44 for more information.

3 Click the Add Recipients button. Select the recipient from the list of contacts 
on the left and click the arrow button pointing to the right. If you do not have 
a contact card created for the recipient, type the phone number in the Number 
box and click the arrow button. Note that you can send the message to several 
recipients.
When you have selected the recipients, click OK.

4 To send the message, click  on the toolbar.

Sending of text messages may fail if, for example, the message center number is 
incorrect. To send a failed message again, click Resend

Reply to text messages
1 On the Inbox page, select the message to which you want to reply.
2 Click  on the toolbar, or click Reply on the File menu. The Message Editor 

dialog box opens.
3 In the Message field, type your reply.
4 To send the message, click  on the toolbar.

Forward text messages
1 On the Inbox page, select the message you want to forward. To forward a 

message you have sent to someone, go to the Sent messages page and select 
the message.

2 Click  on the toolbar, or click Forward on the File menu. The Message 
Editor dialog box opens.

3 Click the Add Recipients button. Select the recipient from the list of contacts 
on the left and click the arrow button pointing to the right. If you do not have 
a contact card created for the recipient, type the phone number in the Number 
box and click the arrow button. Note that you can send the message to several 
recipients.
When you have selected the recipients, click OK.

4 To send the message, click  on the toolbar.

Delete text messages and delivery reports
To delete a text message:
1 On the Inbox page, select the message you want to delete. To delete an unsent 

message, go to the Outbox page, and to delete a sent message, go to the Sent 
messages page.
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2 Click  on the toolbar, or click Delete on the File menu. To delete all 
messages, click Delete All on the File menu.

To delete delivery reports:
1 On the Delivery reports page, select the delivery report you want to delete.
2 Click  on the toolbar, or click Delete on the File menu. By clicking the Clear 

List button you can delete the whole list of reports.

Configure message settings
1 On the Tools menu, click Nokia D311 PC card. The Manager window of the 

Nokia D311 PC card opens.
2 Go to the Settings page and select the GSM tab. Click Advanced Settings.
3 The Advanced GSM Settings dialog box opens. Select the Messages tab.
4 Make the necessary changes. See “Messages” on page 31 for more 

information.
5 When you have configured the necessary settings, click OK.

Picture messages
You can send and receive text messages that contain pictures. These messages are 
called picture messages.

Note that:

• This function can be used only if it is supported by your wireless provider. Only 
devices that offer picture message features can receive and display picture 
messages.

• Each picture message is made up of three text messages. Therefore, sending 
one picture message may cost more than sending one text message.

• Before you can send any picture messages, you need to save your message 
centre number. See “Configure message settings” earlier in this section for 
more information.

• Make sure you have either a GSM or GPRS connection type selected. You 
cannot send or receive messages when connected to WLAN.

Send picture messages
1 Click  on the toolbar, or click New on the File menu. The Message Editor 

dialog box opens.
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2 To insert a picture, click  on the toolbar. The Picture Library dialog box 
opens.

3 Select the picture you want to attach to the message and click OK. 
If there are no pictures available in the list, click  to draw a new picture or 
import a picture from a file by clicking . See “Draw and edit pictures” on 
page 45 and “Open pictures from a file” on page 46 for more information.

4 In the Message field, type the message. The character counter above the field 
shows how many characters you have left and in how many messages the text 
will be sent. 

5 Click the Add Recipients button. Select the recipient from the list of contacts 
on the left and click the arrow button pointing to the right. If you do not have 
a contact card created for the recipient, type the phone number in the Number 
box and click the arrow button. Note that you can send the message to several 
recipients. When you have selected the recipients, click OK.

6 To send the message, click  on the toolbar.

Sending of text messages may fail if, for example, the message center number is 
incorrect. To send a failed message again, click Resend

Draw and edit pictures
1 On the Tools menu, click Picture Library.
2 To draw a new picture, click  on the toolbar. To edit a picture, select the 

picture and click on the toolbar. The Picture Editor dialog box opens.
3 Move the mouse cursor to the desired position. The cursor appears as a pen on 

the drawing area. Press down the left mouse button. Move the mouse to draw. 
The left mouse button draws black color, and the right mouse button draws 
white color. To stop drawing, release the mouse button. Click Save to save the 
picture.

4 Click Close to close the Picture Library dialog box.

Save pictures to a file
1 On the Tools menu, click Picture Library.
2 Select the picture you want to save to a file. Click  on the toolbar.
3 In the Export Picture dialog box, type a name for the file. By default, pictures 

are saved as picture message files in gms format. Click Save.
4 Click Close to close the Picture Library dialog box.
If you have received a picture message, you can add the picture to the Picture 
Library by clicking Save Picture on the File menu.
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Open pictures from a file
1 On the Tools menu, click Picture Library.
2 Click  on the toolbar. 
3 In the Import Picture dialog box, select or type the name of the file you want 

to import to the Picture Library. Click Open.
4 Click Close to close the Picture Library dialog box.

Delete pictures
1 On the Tools menu, click Picture Library.
2 Select the picture you want to remove and click  on the toolbar.
3 Click Close to close the Picture Library dialog box.

Contacts
Contacts are names and phone numbers that have been saved in the SIM card’s 
memory.

Create and edit contacts
1 On the Contacts page, click New to create a new contact. To edit a contact, 

click Edit. The Contact Information dialog box opens.
2 Type the name and phone number for the contact. Click OK.
If you receive a message from a phone number that is not stored on your SIM card, 
you can save the number to the list of contacts by clicking Add To Contacts on the 
File menu.

Delete contacts
1 On the Contacts page, select the contact you want to delete. 
2 Click  on the toolbar, or click Delete.

Send business cards
When you send or receive a person’s contact information, the term business card 
is used. A business card is a contact card in a format suitable for transmission, 
such as vCard format.

1 On the Contacts page, select the contact you want to send as a business card. 
Click Send. 
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2 The Send Business Card dialog box opens. Type the phone number of the 
recipient, or click Select to select the recipient from the list of contacts.

3 Click Send to send the business card.

Make sure you have either a GSM or GPRS connection type selected. You cannot 
send business cards when connected to WLAN.

Chat
The chat function allows you to have a conversation with another person using 
text messages. The other party must have either the Nokia D311 PC card or a 
mobile phone with the SMS capability.

Make sure you have either a GSM or GPRS connection type selected. You cannot 
send or receive messages when connected to WLAN.

Configure chat settings
1 On the Tools menu, click Options.
2 You can configure the following chat settings:

You can specify the number of hours for which the chat messages are shown in 
the Chat window during the conversation.

Chat name – Nickname that is displayed with your chat messages.

Always show chat window on top – Select this if you want the chat window to 
remain visible even when you have other applications open.

3 Click OK to apply the settings.

Start a chat session
1 On the Contacts page, select the contact you want to start a chat session with. 

If you do not have a contact card created for the other party, you have to create 
one first. See “Create and edit contacts” on page 46 for more information. 

2 Click  on the toolbar, or click Chat on the Tools menu.
3 The Chat dialog box opens. Write the message in the Message field and click 

 to send the message.
4 When you receive a reply from the other party, the reply message is shown 

automatically in the Chat window. It is not stored in Inbox.
You can save the chat conversation to a text file. Click  on the toolbar to save 
the file.

You can also attach pictures to your chat messages. See “Picture messages” on 
page 44 for more information on how to handle pictures in messages.
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Troubleshooting

Installation
The installation program is interrupted.

Make sure you have enough battery power on your computer.

Make sure that you have at least 20MB of free disk space on your computer.

Make sure you have enough free resources (such as RAM) available on your 
computer.

Check that you have closed all Windows applications before starting the 
installation, and that you have not inserted the PC card into your computer until 
prompted to do so by the installation program.

The CD-ROM drive cannot be opened during installation.

Some CD-ROM drives cannot be opened when installing software from them. If 
you think that you might need the operating system files during the installation, 
it is advisable that you first copy the Nokia D311 PC card installation files to the 
hard drive of your compatible PC and install the program from there.

The PC card cannot be inserted into the PC card slot.

Check that the PC card is turned the right side up.

Check the PC card slot for any problems.

After inserting the PC card, it takes a while before the computer responds. 

There might be a pause while the driver initializes the PC card. This is normal. 
Please wait until the next message box appears and tells you what to do. This 
should not take more than a few minutes.

Installation to a network drive fails.

You cannot install the Nokia D311 PC card software onto a network drive. The 
software must always be installed on a local hard drive.

I do not have a CD-ROM drive on my computer.

Using another computer, copy the installation program on floppy disks. On the 
CD-ROM there is a folder at English\Setup. Copy the contents of this folder on 
floppy disks. It is recommended that you then copy the contents of the disks to the 
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hard drive of your compatible PC before installing. If installed directly from the 
floppy disks, the system will ask you to change the disk several times.

Network
The PC card seems to be working, but the network connection does not work.

Run the fault diagnosis tests on the Tools page. If all tests are passed successfully, 
make sure that the network settings are correct. Ask your system administrator for 
advice.

In Windows 98/Me, Network Neighborhood does not show my computer name at all. Other 
computers cannot see my computer name in Network Neighborhood either. 

Open the Network dialog box (click Start, Settings, Control Panel, Network) and 
click the File and Print Sharing button. Make sure that the I want to be able to 
give others access to my files check box is selected. Other users should now be 
able to see your computer in Network Neighborhood. If you share folders on your 
computer, other users can see them too.

I cannot access the Internet.

When using a WLAN connection type, check that you use a routing protocol such 
as TCP/IP.

Make sure that the proxy settings in the Web browser are correct.

Make sure that the network which you are accessing has a connection to 
the Internet.

Resources
The PC card does not work and this is probably caused by another installed device.

Check that the PC card is not trying to use an I/O, IRQ, or memory address used by 
another device in your computer. To check the status of resources in Windows 98/
Me, click Start - Settings - Control Panel - System - Device Manager - Network 
Adapters. If there is a conflict, a yellow symbol is shown in front of the name of 
the device.
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Hardware
I am not sure if the PC card is working.

Check in the Monitor window that the PC card is working. You can also check the 
Status page for the status of the connection. 

There are no resource conflicts, but the PC card still does not work.

Check that the operating environment does not cause damage or interference to 
the PC card. Detailed information on the operating environment can be found in 
the chapter “About data transmission” on page 4.

Check that the PC card is properly inserted.

Run fault diagnosis tests on the Tools page.

You can try to determine whether the problem lies with the computer or the PC 
card by using the card in another available PC card slot, by installing the card in 
another computer, or by using another card in the first computer.

The PC card does not work in another PC card slot, but works in another computer. 

Try to insert another PC card in the slot to determine if there is a compatibility 
problem between the Nokia D311 PC card and the PC card slot, or if there is a 
general fault with the slot.

The SIM card is not detected by the PC card.

Make sure that you are using a correct type of SIM card. The PC card does not 
support 5 Volt SIM cards.

Make sure that the SIM card is inserted correctly: the connectors on the SIM card 
and the PC card must meet.

Note: You can find the latest troubleshooting information in the 
readme.txt file on the Nokia D311 PC card CD-ROM.

Tip: On the Tools page you can run fault diagnosis tests and save the test 
results to a text file. The report can be useful if you need, for example, to 
contact technical support in problem situations. 
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Care and maintenance

Your Nokia D311 PC card is a product of superior design and craftsmanship and 
should be treated with care. The suggestions below will help you to fulfil any 
warranty obligations and to enjoy this product for many years.

• Keep the PC card and all its parts and accessories out of small children's reach.

• Keep the PC card dry. Precipitation, humidity, and all types of liquids or 
moisture can contain minerals that will corrode electronic circuits.

• Do not use or store the PC card in dusty, dirty areas.

• Do not store the PC card in hot areas. High temperatures can shorten the life of 
electronic devices, and warp or melt certain plastics.

• Do not store the PC card in cold areas. When it warms up (to its normal 
temperature), moisture can form inside, which may damage electronic circuit 
boards.

• Do not attempt to open the PC card. Non expert handling may damage it.

• Do not drop, knock, or shake the PC card. Rough handling can break internal 
circuit boards. 

• Do not use harsh chemicals, cleaning solvents, or strong detergents to clean 
the PC card.

• Do not paint the PC card. Paint can prevent proper operation.

• Use only the supplied antenna. Unauthorized antennas, modifications, or 
attachments could damage the PC card and may violate regulations governing 
radio devices.

If your PC card is not working properly, take it to your nearest qualified service 
facility. The personnel there will assist you, and if necessary, arrange for service.
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Important safety information

Traffic safety
Do not use the PC card while driving a vehicle. Do not place the PC card on the 
passenger seat or where it can break loose in a collision or sudden stop.

Remember: road safety always comes first!

Operating environment
Remember to follow any special regulations in force in any area and always power 
off your PC card whenever it is forbidden to use it, or when it may cause 
interference or danger. The Nokia D311 PC card may cause interference similar to 
any cellular device (such as a mobile phone) and must not be used in areas where 
the use of any such device is prohibited.

Use the PC card in its normal operating position.

The card may feel hot; this is normal.

Electronic devices
Most modern electronic equipment is shielded from radio frequency (RF) signals. 
However, certain electronic equipment may not be shielded against the RF signals 
from your PC card.

Pacemakers
Pacemaker manufacturers recommend that a minimum separation of 20 cm (6 
inches) be maintained between a PC card and a pacemaker to avoid potential 
interference with the pacemaker. These recommendations are consistent with the 
independent research by and recommendations of Wireless Technology Research. 
Persons with pacemakers: 

• Should always keep the PC card more than 20 cm (6 inches) from their 
pacemaker when the PC card is powered on.

• Should not carry the PC card in a breast pocket.

• If you have any reason to suspect that interference is taking place, power off 
your PC card immediately.

Hearing aids
Some digital PC cards may interfere with some hearing aids. In the event of such 
interference, you may want to consult your wireless provider.
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Other medical devices
Operation of any radio transmitting equipment, including PC cards, may interfere 
with the functionality of inadequately protected medical devices. Consult a 
physician or the manufacturer of the medical device to determine if they are 
adequately shielded from external RF energy or if you have any questions. Power 
off your PC card in health care facilities when any regulations posted in these 
areas instruct you to do so. Hospitals or health care facilities may be using 
equipment that could be sensitive to external RF energy.

Vehicles
RF signals may affect improperly installed or inadequately shielded electronic 
systems in motor vehicles (for example, electronic fuel injection systems, 
electronic anti-skid (anti-lock) braking systems, electronic speed control systems, 
air-bag systems). Check with the manufacturer or its representative regarding 
your vehicle. You should also consult the manufacturer of any equipment that has 
been added to your vehicle.

Posted facilities
Ensure the Nokia D311 PC card is not powered on in any facility where posted 
notices so require.

Potentially explosive atmospheres
Power off your PC card when located in any area with a potentially explosive 
atmosphere and obey all signs and instructions. Sparks in such areas could cause 
an explosion or fire resulting in bodily injury or even death.

Users are advised to power off the PC card when at a refuelling point (service 
station). Users are reminded of the need to observe restrictions on the use of radio 
equipment in fuel depots (fuel storage and distribution areas), chemical plants, or 
where blasting operations are in progress.

Areas with a potentially explosive atmosphere are often but not always clearly 
marked. These include below deck on boats; chemical transfer or storage facilities; 
vehicles using liquified petroleum gas (such as propane or butane); areas where 
the air contains chemicals or particles, such as grain, dust, or metal powders; and 
any other area where you would normally be advised to turn off your vehicle 
engine.

Vehicles
For vehicles equipped with an air bag, remember that an air bag inflates with great 
force. Do not place objects in the area over the air bag or in the air bag deployment 
area. Serious injury could result if the PC card is improperly placed and the air bag 
inflates.
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Using your PC card while in the air is prohibited. Remove your PC card from the PC 
card slot before boarding an aircraft. The use of PC cards in an aircraft may be 
dangerous to the operation of the aircraft, disrupt the wireless telephone network 
and may be illegal.

Failure to observe these instructions may lead to suspension or denial of 
telephone services to the offender, or legal action or both.

Antenna
The Nokia D311 PC card has a built-in antenna. As with any other radio-
transmitting device, avoid touching the antenna while the PC card is on. Contact 
with the antenna affects connection quality and may cause the PC card to operate 
at a higher power level than necessary.

FCC Notice: This device complies with part 15 of the FCC Rules. Operation is 
subject to the following two conditions: (1) this device may not cause harmful 
interference and (2) this device must accept any interference received including 
interference that may cause undesired operation. 

This PC card has been tested and meets FCC RF exposure guidelines when used in 
a position that keeps the antenna at least 3/4 inch (1.9cm) from your body when 
the PC card is switched on. When used with a laptop computer on your lap, the 
snap-on spacer can be used to provide the required 3/4 inch (1.9cm) distance.

Slide the snap-on spacer on the PC card in the direction of arrow 1. Then insert the 
PC card into the PC card slot of the computer.

Figure 7 - Installing the snap-on spacer

1
snap-on spacer
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Access controller

Physical device that manages permission and restrictions for logging onto a 
computer or network. 

Ad hoc

One of the two WLAN operating modes that can be selected when using the Nokia 
D311 PC card. With this configuration option, users can set up a wireless local 
area network where wireless stations can send and receive data directly with each 
other without WLAN access points. This type of network is sometimes called a 
peer-to-peer network.

Dual-band functionality

Dual-band functionality provides seamless roaming between networks during a 
call within the same wireless provider. In practice, this means that you are less 
likely to get “Network busy” messages. When you are abroad, dual-band 
functionality gives more roaming possibilities, depending on your wireless 
provider's roaming agreement.

GPRS

General Packet Radio Service. GPRS is a technology that enables sending and 
receiving data over a mobile network. GPRS as such is a data bearer that enables 
wireless access to data networks like the Internet. The applications that use GPRS 
are SMS messaging and the GPRS dial-up (for example, Internet and e-mail).

GPRS access point

Interface between a GPRS network and external packet data networks, such as
the Internet.

GSM

GSM (Global System for Mobile Communications) is a digital telecommunications 
system used widely in Europe, Asia and the Pacific.

Home network

Your home network is the network run by the operator that issued your SIM card.
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Infrastructure
One of the two WLAN operating modes that can be selected when using the Nokia 
D311 PC card. With this configuration option users can set up a wireless local area 
network where wireless stations communicate with wired and wireless stations 
through a WLAN access point.

Network operator
A network operator maintains a cellular telecommunications network in a specific 
area. Several network operators may have overlapping networks.

Network services
Special services provided by wireless providers. These services must be subscribed 
to, and typically include the Short Message Service (SMS), data service and 
fax service.

Picture message

Text message that contains pictures. Each picture message is made up of several 
text messages. This function can be used only if it is supported by your wireless 
provider. Only devices that offer the picture message feature can receive and 
display pictures. 

PIN code

Personal Identification Number code. PIN code (4 to 8 digits) is an access code for 
protecting a SIM card against unauthorized use.

Profile

A profile is a group of network-specific and Windows networking settings. Profiles 
enable easy transfer from one network to another without having to remember all 
the different settings.

PUK code

PIN Unblocking Key code. PUK is a 8-digit code supplied with the SIM card. The 
code is needed when you want to change a blocked PIN code. You cannot change 
the PUK code. If you lose the code, contact your wireless provider.

Restriction password

The restriction password is a 4-digit code needed to change call restrictions. The 
password is not located in your PC card or SIM card, but in the network. You obtain 
the password from your wireless provider when you subscribe to the call 
restriction service.
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Security code
The security code is supplied with the PC card. It protects your PC card against 
unauthorized use. Keep the code secret and in a safe place, separate from the PC 
card. If you key in an incorrect security code five times in succession, the PC card 
will not accept the correct code for the next five minutes.

Short message
See “Text message”.

SIM card
Subscriber Identity Module card. A small plastic card with an embedded 
integrated circuit. The SIM card contains all the information the cellular network 
needs to identify the network user. The SIM card also contains security-related 
information.

SMS

Short Message Service. SMS is a network service provided by wireless providers. It 
enables sending and receiving short text messages over the digital cellular 
network. The standard length of a text message is 160 characters.

Text message

Short message that is sent over the digital cellular network. The standard length of 
a text message is 160 characters.

WEP

Wired Equivalent Privacy. A security feature using the RC4 algorithm that 
performs wireless data encryption. The WEP algorithm uses up to 152-bit keys.

Wireless provider

A company that offers telecommunications services, such as network services. A 
wireless provider may be a network operator or a separate company.

Wireless providers offer a variety of network services, including GSM data services 
such as the Short Message Service (SMS). Not all wireless providers provide 
exactly the same services.

Wireless station

Any computing device with a PC card slot, into which the PC card can be inserted 
in order to send and receive data.
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WLAN
Wireless Local Area Network. A local area network in which radio links are used to 
connect devices instead of physical cables.

WLAN access point
Physical device that connects wired and wireless networks together.
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Nokia One-Year Limited Warranty

Nokia Inc. (“Nokia”) warrants that this PC card (“Product”) is 
free from defects in material and workmanship that result in 
Product failure during normal usage, according to the 
following terms and conditions:

1 The limited warranty for the Product extends for ONE (1) 
year beginning on the date of the purchase of the 
Product. This one year period is extended by each whole 
day that the Product is out of your possession for repair 
under this warranty.

2 The limited warranty extends only to the original 
purchaser (“Consumer”) of the Product and is not 
assignable or transferable to any subsequent purchaser/
end-user.

3 The limited warranty extends only to Consumers who 
purchase the Product in the United States of America.

4 During the limited warranty period, Nokia will repair, or 
replace, at Nokia’s sole option, any defective parts, or any 
parts that will not properly operate for their intended use 
with new or refurbished replacement items if such repair 
or replacement is needed because of product malfunction 
or failure during normal usage. No charge will be made to 
the Consumer for any such parts. Nokia will also pay for 
the labor charges incurred by Nokia in repairing or 
replacing the defective parts. The limited warranty does 
not cover defects in appearance, cosmetic, decorative or 
structural items, including framing, and any non-
operative parts. Nokia’s limit of liability under the limited 
warranty shall be the actual cash value of the Product at 
the time the Consumer returns the Product for repair, 
determined by the price paid by the Consumer for the 
Product less a reasonable amount for usage. Nokia shall 
not be liable for any other losses or damages. These 
remedies are the Consumer’s exclusive remedies for 
breach of warranty.

5 Upon request from Nokia, the Consumer must prove the 
date of the original purchase of the Product by a dated bill 
of sale or dated itemized receipt.

6 The Consumer shall bear the cost of shipping the Product 
to Nokia in Melbourne, Florida. Nokia shall bear the cost 
of shipping the Product back to the Consumer after the 
completion of service under this limited warranty.

7 The Consumer shall have no coverage or benefits under 
this limited warranty if any of the following conditions 
are applicable:

a) The Product has been subjected to abnormal use, 
abnormal conditions, improper storage, exposure to 

moisture or dampness, unauthorized modifications, 
unauthorized connections, unauthorized repair, misuse, 
neglect, abuse, accident, alteration, improper 
installation, or other acts which are not the fault of 
Nokia, including damage caused by shipping.

b) The Product has been damaged from external causes 
such as collision with an object, or from fire, flooding, 
sand, dirt, windstorm, lightning, earthquake or damage 
from exposure to weather conditions, an Act of God, or 
battery leakage, theft, blown fuse, or improper use of any 
electrical source, damage caused by computer or internet 
viruses, bugs, worms, Trojan Horses, cancelbots or 
damage caused by the connection to other products not 
recommended for interconnection by Nokia.

c) Nokia was not advised in writing by the Consumer of 
the alleged defect or malfunction of the Product within 
fourteen (14) days after the expiration of the applicable 
limited warranty period.

d) The Product serial number plate or the accessory data 
code has been removed, defaced or altered.

e) The defect or damage was caused by the defective 
function of the cellular system or by inadequate signal 
reception by the external antenna, or viruses or other 
software problems introduced into the Product.

8 Nokia does not warrant uninterrupted or error-free 
operation of the Product. If a problem develops during the 
limited warranty period, the Consumer shall take the 
following step-by-step procedure:

a) The Consumer shall return the Product to the place of 
purchase for repair or replacement processing.

b) If “a” is not convenient because of distance (more than 
50 miles) or for other good cause, the Consumer shall ship 
the Product prepaid and insured to:

Nokia Inc., Attn: Repair Department

795 West Nasa Blvd.

Melbourne, FL 32901

c) The Consumer shall include a return address, daytime 
phone number and/or fax number, complete description 
of the problem, proof of purchase and service agreement 
(if applicable). Expenses related to removing the Product 
from an installation are not covered under this limited 
warranty.

d) The Consumer will be billed for any parts or labor 
charges not covered by this limited warranty. The 
 reserved.
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Consumer will be responsible for any expenses related to 
reinstallation of the Product.

e) Nokia will repair the Product under the limited 
warranty within 30 days after receipt of the Product. If 
Nokia cannot perform repairs covered under this limited 
warranty within 30 days, or after a reasonable number of 
attempts to repair the same defect, Nokia at its option, 
will provide a replacement Product or refund the 
purchase price of the Product less a reasonable amount 
for usage. In some states the Consumer may have the 
right to a loaner if the repair of the Product takes more 
than ten (10) days. Please contact the Customer Service 
Center at Nokia at the telephone number listed at the end 
of this warranty if you need a loaner and the repair of the 
Product has taken or is estimated to take more than ten 
(10) days.

f) If the Product is returned during the limited warranty 
period, but the problem with the Product is not covered 
under the terms and conditions of this limited warranty, 
the Consumer will be notified and given an estimate of 
the charges the Consumer must pay to have the Product 
repaired, with all shipping charges billed to the consumer. 
If the estimate is refused, the Product will be returned 
freight collect. If the Product is returned after the 
expiration of the limited warranty period, Nokia’s normal 
service policies shall apply and the Consumer will be 
responsible for all shipping charges.

9 You (the Consumer) understand that the product may 
consist of refurbished equipment that contains used 
components, some of which have been reprocessed. The 
used components comply with Product performance and 
reliability specifications.

10 ANY IMPLIED WARRANTY OF MERCHANTABILITY, OR 
FITNESS FOR A PARTICULAR PURPOSE OR USE, SHALL BE 
LIMITED TO THE DURATION OF THE FOREGOING LIMITED 
WRITTEN WARRANTY. OTHERWISE, THE FOREGOING 
LIMITED WARRANTY IS THE CONSUMER’S SOLE AND 
EXCLUSIVE REMEDY AND IS IN LIEU OF ALL OTHER 
WARRANTIES, EXPRESS OR IMPLIED. NOKIA SHALL NOT 
BE LIABLE FOR SPECIAL, INCIDENTAL, PUNITIVE OR 
CONSEQUENTIAL DAMAGES, INCLUDING BUT NOT 
LIMITED TO LOSS OF ANTICIPATED BENEFITS OR PROFITS, 
LOSS OF SAVINGS OR REVENUE, LOSS OF DATA, PUNITIVE 
DAMAGES, LOSS OF USE OF THE PRODUCT OR ANY 
ASSOCIATED EQUIPMENT, COST OF CAPITAL, COST OF 
ANY SUBSTITUTE EQUIPMENT OR FACILITIES, 
DOWNTIME, THE CLAIMS OF ANY THIRD PARTIES, 
INCLUDING CUSTOMERS, AND INJURY TO PROPERTY, 
RESULTING FROM THE PURCHASE OR USE OF THE 
PRODUCT OR ARISING FROM BREACH OF THE 
WARRANTY, BREACH OF CONTRACT, NEGLIGENCE, 
STRICT TORT, OR ANY OTHER LEGAL OR EQUITABLE 
THEORY, EVEN IF NOKIA KNEW OF THE LIKELIHOOD OF 

SUCH DAMAGES. NOKIA SHALL NOT BE LIABLE FOR 
DELAY IN RENDERING SERVICE UNDER THE LIMITED 
WARRANTY, OR LOSS OF USE DURING THE PERIOD THAT 
THE PRODUCT IS BEING REPAIRED.

11 Some states do not allow limitation of how long an 
implied warranty lasts, so the one year warranty 
limitation may not apply to you (the Consumer). Some 
states do not allow the exclusion or limitation of 
incidental and consequential damages, so certain of the 
above limitations or exclusions may not apply to you (the 
Consumer). This limited warranty gives the Consumer 
specific legal rights and the Consumer may also have 
other rights which vary from state to state.

12 Nokia neither assumes nor authorizes any authorized 
service center or any other person or entity to assume for 
it any other obligation or liability beyond that which is 
expressly provided for in this limited warranty including 
the provider or seller of any extended warranty or service 
agreement.

13 This is the entire warranty between Nokia and the 
Consumer, and supersedes all prior and 
contemporaneous agreements or understandings, oral or 
written, relating to the Product, and no representation, 
promise or condition not contained herein shall modify 
these terms. 

14 This limited warranty allocates the risk of failure of the 
Product between the Consumer and Nokia. The allocation 
is recognized by the Consumer and is reflected in the 
purchase price.

15 Any action or lawsuit for breach of warranty must be 
commenced within eighteen (18) months following 
purchase of the Product.

16 Questions concerning this limited warranty may be 
directed to:

Nokia Inc.

Attn: Customer Service

7725 Woodland Center Blvd., Ste. 150

Tampa, FL 33614

Telephone: 1-888-NOKIA-2U (1-888-665-4228)

Facsimile: (813) 287-6612

TTY/TDD Users Only: 1-800-24-NOKIA (1-800-246-
6542)

17 The limited warranty period for Nokia supplied 
attachments and accessories is specifically defined 
within their own warranty cards and packaging.
 reserved.
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